Copyright and Trademarks

©1999 Lucent Technologies. All rights reserved. PortMaster, ComOS, and ChoiceNet are registered trademarks of Lucent Technologies Inc. PMVision, IRX, and PortAuthority are trademarks of Lucent Technologies Inc. PolicyFlow is a service mark of Lucent Technologies Inc. All other marks are the property of their respective owners.

Disclaimer

Lucent Technologies Inc. makes no express or implied representations or warranties with respect to the contents or use of this manual, and specifically disclaims any implied warranties of merchantability or fitness for a particular purpose. Lucent Technologies Inc. further reserves the right to revise this manual and to make changes to its content at any time, without obligation to notify any person or entity of such revisions or changes.
About This Guide

Audience .......................................................... v
PortMaster Documentation .................................. v
Additional References ........................................ vi
RFCs ............................................................... vi
Books .............................................................. vii

Document Conventions ....................................... viii
Document Advisories .......................................... ix
Contacting Lucent NetCare Technical Support .......... ix
  For the EMEA Region ........................................ ix
  For North America, CALA, and the Asia Pacific Region .......... x
PortMaster Training Courses ................................ x
Subscribing to PortMaster Mailing Lists .................. x
................................................................. xi

1. PMVision Capabilities

Monitor .......................................................... 1-2
Graph ............................................................. 1-2
Diagnose ......................................................... 1-3
Maintain ......................................................... 1-3
Command ......................................................... 1-3
Configure ......................................................... 1-3

2. Using PMVision

Starting PMVision ............................................. 2-1
PMVision Interface ............................................. 2-1
  Control Tree Panel .......................................... 2-2
  Connection Panel .......................................... 2-2
  Main Panel .................................................. 2-3
  Menu Bar ..................................................... 2-3
  Status Bar ................................................... 2-3
  Help Bar ..................................................... 2-3
Connecting to a Device .................................................. 2-3
Basic Connection .................................................. 2-3
Connecting to Multiple Devices ........................................ 2-4
Viewing and Configuring the PortMaster 4 vs. Other Devices ........ 2-4
Integrated PortMaster Products ........................................ 2-4
Integrated Network Access Module (INA) ............................ 2-5
PortMaster 4 ............................................................ 2-5
PMVision Functions .................................................. 2-6
Monitor Functions .................................................. 2-6
Graph Functions .................................................. 2-8
Diagnose Functions .................................................. 2-9
Maintain Functions .................................................. 2-10
Command Functions .................................................. 2-12
Configure Functions .................................................. 2-13

3. PMVision Installation

System Requirements .................................................. 3-1
Installation Instructions .................................................. 3-1
Deinstallation .................................................. 3-2
Command Line Features .................................................. 3-3
Login Options .................................................. 3-3
Debug Options .................................................. 3-3

A. Lucent Technologies InterNetworking Systems Global Warranty

Index
About This Guide

The PMVision User’s Guide provides complete instructions for installing, configuring, and using PMVision™.

PMVision works best with PortMaster®, and MERLIN MAGIX Integrated Network Access (INA) Module products running ComOS® release 3.7 or later. For full functionality, use ComOS 3.8.2 or later. To install and configure these Lucent Technologies products, see “PortMaster Documentation” on page viii.

Audience

This guide is designed to be used by qualified system administrators and network managers. Knowledge of UNIX, Microsoft Windows 9x, Windows NT, or MacIntosh OS and basic networking concepts is required to successfully install PMVision. To use PMVision with PortMaster or INA module products you must be familiar with their installation, configuration, and use.

PortMaster Documentation

The following manuals are available from Lucent. The hardware installation guides are included with most PortMaster products; other manuals can be ordered through your PortMaster distributor or directly from Lucent.

The manuals are also provided as PDF and PostScript files on the PortMaster Software CD shipped with your PortMaster.

In addition, you can download PortMaster information and documentation from http://www.livingston.com.

- ChoiceNet® Administrator’s Guide
  This guide provides complete installation and configuration instructions for ChoiceNet server software.

- MERLIN MAGIX™ Integrated Network Access (INA) Module Installation and Configuration Guide
  This guide provides complete installation and configuration instructions for the MERLIN MAGIX Integrated Network Access module.

- PortMaster 4 User Manual

This collection of the following three standalone manuals provides instructions and commands for installing, configuring, and troubleshooting PortMaster 4 products:

- PortMaster 4 Installation Guide
- PortMaster 4 Configuration Guide
- PortMaster 4 Command Line Reference
It also includes a comprehensive table of contents, glossary, and master indexes.

- **PortMaster Command Line Reference**
  
  This reference provides the complete description and syntax of each command in the ComOS command set.

- **PortMaster Configuration Guide**
  
  This guide provides a comprehensive overview of networking and configuration for PortMaster products.

- **PortMaster hardware installation guides**
  
  These guides contain complete hardware installation instructions. An installation guide is shipped with each PortMaster.

- **PortMaster Routing Guide**
  
  This guide describes routing protocols supported by PortMaster products, and how to use them for a wide range of routing applications.

- **PortMaster Troubleshooting Guide**
  
  This guide can be used to identify and solve software and hardware problems in the PortMaster family of products.

- **RADIUS for UNIX Administrator’s Guide**
  
  This guide provides complete installation and configuration instructions for Lucent Remote Authentication Dial-In User Service (RADIUS) software on UNIX platforms.

- **RADIUS for Windows NT Administrator’s Guide**
  
  This guide provides complete installation and configuration instructions for Lucent Remote Authentication Dial-In User Service (RADIUS) software on the Microsoft Windows NT platform.

### Additional References

**RFCs**

To find a Request for Comments (RFC) online, visit the website of the Internet Engineering Task Force (IETF) at [http://www.ietf.org/](http://www.ietf.org/).

- RFC 768, User Datagram Protocol
- RFC 791, Internet Protocol
- RFC 792, Internet Control Message Protocol
- RFC 793, Transmission Control Protocol
- RFC 854, Telnet Protocol Specification
- RFC 950, Internet Standard Subnetting Procedure
- RFC 1058, Routing Information Protocol
- RFC 1112, Host Extensions for IP Multicasting
- RFC 1144, Compressing TCP/IP Headers for Low-Speed Serial Links
- RFC 1157, A Simple Network Management Protocol (SNMP)
- RFC 1166, Internet Numbers
Additional References

RFC 1212, Concise MIB Definitions
RFC 1213, Management Information Base for Network Management of TCP/IP-based Internets: MIB-II
RFC 1256, ICMP Router Discovery Messages
RFC 1321, The MD5 Message-Digest Algorithm
RFC 1331, The Point-to-Point Protocol (PPP) for the Transmission of Multiprotocol Datagrams over Point-to-Point Links
RFC 1332, The PPP Internet Protocol Control Protocol (IPCP)
RFC 1334, PPP Authentication Protocols
RFC 1349, Type of Service in the Internet Protocol Suite
RFC 1413, Identification Protocol
RFC 1490, Multiprotocol Interconnect Over Frame Relay
RFC 1541, Dynamic Host Configuration Protocol
RFC 1542, Clarifications and Extensions for the Bootstrap Protocol
RFC 1552, The PPP Internet Packet Exchange Control Protocol (IPXCP)
RFC 1587, OSPF NSSA Options
RFC 1597, Address Allocations for Private Internets
RFC 1627, Network 10 Considered Harmful (Some Practices Shouldn’t be Codified)
RFC 1634, Novell IPX Over Various WAN Media (IPXWAN)
RFC 1661, The Point-to-Point Protocol (PPP)
RFC 1700, Assigned Numbers
RFC 1723, RIP Version 2
RFC 1771, A Border Gateway Protocol 4 (BGP-4)
RFC 1812, Requirements for IP Version 4 Routers
RFC 1814, Unique Addresses are Good
RFC 1818, Best Current Practices
RFC 1824, Requirements for IP Version 4 Routers
RFC 1825, Security Architecture for the Internet Protocol
RFC 1826, IP Authentication Header
RFC 1827, IP Encapsulating Payload
RFC 1828, IP Authentication Using Keyed MD5
RFC 1829, The ESP DES-CBC Transform
RFC 1851, The ESP Triple DES Transform
RFC 1877, PPP Internet Protocol Control Protocol Extensions for Name Server Addresses
RFC 1878, Variable Length Subnet Table for IPv4
RFC 1918, Address Allocation for Private Internets
RFC 1962, The PPP Compression Control Protocol (CCP)
RFC 1965, Autonomous System Confederations for BGP
RFC 1966, BGP Route Reflection, An Alternative to Full Mesh IBGP
RFC 1974, PPP Stac LFS Compression Protocol
RFC 1990, The PPP Multilink Protocol (MP)
RFC 1994, PPP Challenge Handshake Authentication Protocol (CHAP)
RFC 1997, BGP Communities Attribute
RFC 2003, IP Encapsulation within IP
RFC 2104, HMAC: Keyed-Hashing for Message Authentication
RFC 2125, The PPP Bandwidth Allocation Protocol (BAP), The PPP Bandwidth Allocation Control Protocol (BACP)
RFC 2138, Remote Authentication Dial In User Service (RADIUS)
RFC 2139, RADIUS Accounting
RFC 2153, PPP Vendor Extensions
RFC 2328, OSPF Version 2
RFC 2400, Internet Official Protocol Standards
RFC 2453, RIP Version 2
Books


Document Conventions

The following conventions are used in this guide:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Use</th>
<th>Examples</th>
</tr>
</thead>
</table>
| **Bold font**    | Indicates a user entry—a command, menu option, button, or key—or the name of a file, directory, or utility, except in code samples. | • Enter `version` to display the version number.  
• Press `Enter`.  
• Open the `permit_list` file. |
| **Italic font**  | Identifies a command-line placeholder. Replace with a real name or value. | • `set Ether0 address 1paddress`  
• Replace `Area` with the name of the OSPF area. |
| **Square brackets ([ ])** | Enclose optional keywords and values in command syntax. | • `set nameserver [2] 1paddress`  
• `set S0 destination 1paddress [1pmask]` |
Document Advisories

**Note** – means take note. Notes contain information of importance or special interest.

**Caution** – means be careful. You might do something—or fail to do something—that results in equipment failure or loss of data.

**Warning** – means danger. You might do something—or fail to do something—that results in personal injury or equipment damage.

## Contacting Lucent NetCare Technical Support

The PortMaster comes with a 1-year hardware warranty. See Appendix A, “Lucent Technologies InterNetworking Systems Global Warranty” for details.

For all technical support requests, record your PortMaster ComOS version number and report it to the staff of Lucent NetCare® Professional Services or your authorized sales channel partner.


### For the EMEA Region

If you are an Internet service provider (ISP) or other end user in Europe, the Middle East, Africa, India, or Pakistan, contact your local Lucent sales channel partner. For a list of authorized sales channel partners, see the World Wide Web at http://www.livingston.com/International/EMEA/distributors.html.

If you are an authorized Lucent sales channel partner in this region, contact the Lucent NetCare EMEA Support Center Monday through Friday, 24 hours a day.

- By voice, dial +33-4-92-38-33-33.
PortMaster Training Courses

- By fax, dial +33-4-92-38-31-88
- By electronic mail (email), send mail to emeacallcenter@lucent.com.

For North America, CALA, and the Asia Pacific Region

Contact Lucent NetCare Monday through Friday between the hours of 7 a.m. and 5 p.m. (GMT -8).
- By voice, dial 800-458-9966 within the United States (including Alaska and Hawaii), Canada, and the Caribbean and Latin America (CALA), or +1-925-737-2100 from elsewhere.
- By email, send mail as follows:
  - From North America and CALA to support@livingston.com.
  - From the Asia Pacific Region to asia-support@livingston.com.
- Using the World Wide Web, see http://www.livingston.com/.

PortMaster Training Courses

Lucent NetCare Professional Services offers hands-on, technical training courses on PortMaster products and their applications. For course information, schedules, and pricing, visit the Lucent website at http://www.livingston.com/tech/training/.

Subscribing to PortMaster Mailing Lists

Lucent maintains the following Internet mailing lists for PortMaster users:

- **portmaster-users**—a discussion of general and specific PortMaster issues, including configuration and troubleshooting suggestions. To subscribe, send email to majordomo@livingston.com with subscribe portmaster-users in the body of the message.
  
  The mailing list is also available in a daily digest format. To receive the digest, send email to majordomo@livingston.com with subscribe portmaster-users-digest in the body of the message.

- **portmaster-radius**—a discussion of general and specific RADIUS issues, including configuration and troubleshooting suggestions. To subscribe, send email to majordomo@livingston.com with subscribe portmaster-radius in the body of the message.
  
  The mailing list is also available in a daily digest format. To receive the digest, send email to majordomo@livingston.com with subscribe portmaster-radius-digest in the body of the message.

- **portmaster-announce**—announcements of new PortMaster products and software releases. To subscribe, send email to majordomo@livingston.com with subscribe portmaster-announce in the body of the message. All announcements to this list also go to the portmaster-users list. You do not need to subscribe to both lists.
• **tech-bulletin@livingston.com**—a moderated push list featuring technical notes, Web links, and information about the latest code and beta releases sent on a weekly basis, as well as periodic technical updates. To subscribe, complete the form at [http://www.livingston.com/tech/bulletin/index.html](http://www.livingston.com/tech/bulletin/index.html).
PMVision is a configuration and monitoring application for Lucent PortMaster products and the MERLIN MAGIX INA module, based on Sun Microsystems’s Java Virtual Machine version 1.1.6.

PMVision provides a single document interface (SDI) panel (Figure 1-1). A control tree is displayed on the left, a list of attached devices appears at the top center, and the main function panel is in the center.

Figure 1-1  PMVision Display

You access PMVision functions by clicking the function name in the control tree. The function categories are

- **Monitor**—Displays information about device operations.
- **Graph**—Displays PortMaster modem and session data.
- **Diagnosis**—Sets debug options and displays traces.
- **Maintenance**—Upgrades ComOS and backs up and restores configurations.
- **Command**—Accesses the ComOS command line interface.
- **Configuration**—Configures device settings and boards.
Monitor

PMVision provides extensive monitoring capabilities, including the ability to monitor diagnostic commands. You can monitor device operations by selecting these functions:

- **Chassis** displays power use, power supply status, fan status, and temperature for each board on a PortMaster 4.
- **Users** displays the list of connected device users.
- **Modem Summary** displays the number of modems in each state.
- **Modem Details** displays the state of modems either for an entire PortMaster 3 chassis or for a single PortMaster 4 Quad T1 or Tri E1 board.
- **Session Summary** displays the total numbers and types of active sessions.
- **Session Details** displays all active sessions for integrated PortMaster products or for a single PortMaster 4 Quad T1 or Tri E1 board.
- **Lines** displays the state of lines for all active devices.
- **Interfaces** displays active interfaces either for integrated PortMaster products or for a single PortMaster 4 Quad T1 or Tri E1 board.
- **Alarms** displays the list of Simple Network Management Protocol (SNMP) alarms.
- **NAT Sessions** displays a list of network address translator (NAT) sessions.
- **NAT Statistics** displays a list of NAT statistics.
- **OSPF Neighbors** displays a list of Open Shortest Path First (OSPF) neighbors.
- **Network Connections** displays a list of network connections.
- **Mux Channels** displays the state of channels on a PortMaster 4 T3 Mux or STS-1 Mux board.
- **Mux Stats** displays the state of the multiplexor line on a PortMaster 4 T3 Mux or STS-1 Mux board.
- **Ethernet** displays the state of all Ethernet connections.
- **DHCP Bindings** displays a list of all Dynamic Host Configuration Protocol (DHCP) bindings.
- **L2TP Tunnels** displays the Layer 2 Tunneling Protocol (L2TP) tunnels.
- **L2TP Sessions** displays the L2TP sessions.

Graph

The Graph function allows you to view and log the history of modem and session summaries. You can specify the log interval, log file, and colors for each item in the display. The colors are saved to a preferences file.
- **Modems** displays and logs the Modem Summary information over time.
- **Sessions** displays and logs the Session Summary information over time.

**Diagnose**

Debug allows you to turn on device debug options and to display the resulting debug trace.

**Maintain**

- **Back Up** allows you to save the entire device configuration or selected parts of your configuration to a file. The configuration information is saved in ASCII file format.

  Passwords and secrets may not always be saved. The administrative (!root) password is never saved for any ComOS version. See “Back Up” on page 2-10 for more information.

- **Restore** allows you to restore a previously saved configuration file. If a selective backup was made, any items that are not overwritten by the restore operation are left unchanged.

- **Upgrade** allows you to upgrade your device with a ComOS upgrade file.

**Command**

Command provides a command window for entering ComOS commands and viewing command output. Commands can be entered into multiple devices simultaneously. Logging to a file and a large scrollable text window provide convenient operation.

**Configure**

Configure functions allows you to enter, view, and update configuration information for the device.

- **Global** configures the standard device global settings using a single data form.
- **Local IP Addresses** configures up to four local IP addresses for the device.
- **Boards** configures individual PortMaster 4 boards.
- **RADIUS** configures settings for RADIUS authentication, authorization, and accounting service.
- **ChoiceNet** configures settings for ChoiceNet filters.
- **SNMP** configures Simple Network Management Protocol parameters and read and write host settings.
- **OSPF** and **OSPF Areas** configure OSPF and OSPF areas parameters.
• **Filters** configures IP, IPX and Service Advertising Protocol (SAP) filters with easy-to-use dialog boxes.

• **NAT Maps** configures Network Address Translator maps.

• **SAs** configures security policies for different peers on a virtual private network (VPN).

• **IPSec Profiles** defines security associations and policy filters used on a router interface.

• **Locations** configures settings for dial-out destinations.

• **Users** defines the nature and behavior of dial-in users.

• **Static Routes** configures routing information in addition to that provided by RIP and other routing protocols.

• **Hosts** creates a local table to map hostnames to IP addresses.

• **Modems** configure settings for modems.

• **Lines** configure settings for ISDN, PRI, T1 and E1 lines.

• **L2TP** configures the Layer 2 Tunneling Protocol settings.

• **Ports** configures settings for asynchronous, ISDN, synchronous, and parallel ports.

• **Ethernets** configures the settings for Ethernet ports.

• **Syslog** configures logging facilities.

• **Subinterfaces** configures subordinate Ethernet subinterfaces.

• **IP Pools** configures IP address pools for dial-in users.

• **DHCP** configures DHCP server settings.
This chapter explains how to start PMVision and connect to one or more PortMaster products or other devices, and describes the PMVision interface and functions. In addition, the chapter contrasts the board-based monitoring and configuration of the PortMaster 4 with other PortMaster products.

Topics are as follows:

• “Starting PMVision” on page 2-1
• “Connecting to a Device” on page 2-3
• “Viewing and Configuring the PortMaster 4 vs. Other Devices” on page 2-4
• “PMVision Functions” on page 2-6

Starting PMVision

Windows NT and Windows 95/98. Select the PMVision icon from the Lucent folder in your Start → Programs menu.

UNIX (including Solaris). Run PMVision by typing pmvision when you are in the pmvision installation directory. If you have added the pmvision installation directory to your PATH, you can run it from anywhere.

Macintosh. Select the PMVision icon from the Apple menu.

PMVision Interface

The PMVision interface is divided into three main panels, two status bars, and a menu bar (Figure 2-1).
Control Tree Panel

The control tree panel allows easy selection of all PMVision functions. It is designed in a directory tree format. A single click activates each function. You can jump from any function to any other function with the single click.

PMVision has six categories of functions: Monitor, Graph, Diagnose, Maintain, Command, and Configure. Each category except Command has a series of subfunctions under it. Expand or collapse a display of subfunctions by double-clicking on the subfunction name.

A special control tree has been added at the bottom of this panel for control of the MERLIN MAGIX INA module. The module uses a special version of the ComOS. See the MERLIN MAGIX Integrated Network Access (INA) Module Installation and Configuration Guide for more information.

Connection Panel

The connection panel displays a list of the devices that are connected to PMVision. The model and ComOS version of each device is displayed in the appropriate column. The Up Time column reports how long the device has been operating since its last reboot. However, if a particular device has become disconnected from PMVision, the Up Time column reports this fact with a “Connection Lost” message.
Main Panel

When you select a function from the control tree, the main panel shows displays of monitoring or configuration information, fields to collect data, or buttons to select further functions. Selecting a major function category such as Monitor or Graph displays buttons in the main panel that lead to further subfunctions. The same functions can also be selected from the control tree.

Clickable buttons such as Save, Refresh, or New Window appear at the bottom of the main panel display. These buttons are appropriate to the particular function being displayed.

Menu Bar

The menu bar contains File, Edit, Device, Windows, and Help menus. Use the File menu to exit PMVision. The Edit menu is used to cut, copy, paste, and delete device configuration data and settings. The Device menu is used to connect to and disconnect from individual device devices. The Windows and Help menus work in the standard manner.

Status Bar

The status bar displays the status of functions while information is being collected from the attached devices.

Help Bar

When fields are displayed in the main panel, the help bar is active. Pointing the cursor at a particular field causes the range of acceptable field values to appear in the help bar.

Connecting to a Device

Use the Device menu and connection panel to control connections to devices. Multiple devices can be accessed and controlled simultaneously, if desired.

Basic Connection

You connect PMVision to a device by selecting Device from the menu bar and clicking Connect. The connection dialog box appears (Figure 2-2). Enter the IP address or Domain Name System (DNS) name of the device into the Device text box. If you have connected to this device before, you can also select the address from the drop-down list box. Complete the dialog by completing the Username and Password text boxes and clicking Connect.
Figure 2-2  Connection Dialog

When the connection has been made, information about the device appears in the connection panel. The device information line is highlighted, indicating that the device is active and can be controlled by PMVision. PMVision is now ready to interact with that device.

Connecting to Multiple Devices

Additional device devices can be accessed simultaneously. Connect to each additional device by selecting the **Device** menu and clicking **Connect** to start the connection dialog. Continue connecting until all desired devices have been contacted.

The next step is to activate those devices you want PMVision to control. From the connection panel, hold down **Shift** or **Control** and then click your mouse button to select the devices you want to activate. The connection panel shows all active devices highlighted.

When multiple devices are activated, the main panel displays information and/or fields, for all the selected devices. Most often, information for each device is displayed sequentially from left to right or from top to bottom. Scroll bars are provided for navigation. Some functions provide a drop-down menu to select the data from a particular device to manage.

Viewing and Configuring the PortMaster 4 vs. Other Devices

Many configuration and monitoring tasks are performed in the same way for all devices. However, the PortMaster 4 and related devices use a hardware architecture based on separate boards and modules, while the other devices use a compact integrated hardware design. Therefore, a number of important configuration and monitoring tasks for the PortMaster 4 are performed on a particular module or board rather than the entire device.

Integrated PortMaster Products

In the PortMaster 3, PortMaster 2, Office Router, and IRX™ router, the electronics are effectively integrated into a single chassis. Commands can be sent to configure, for example, a particular port or modem by means of a single command that addresses the component by name. While the PortMaster 3 does have plug-in modem cards, each modem is automatically assigned a unique modem number when the card is plugged into a particular slot.
To monitor settings on one of these products, click an appropriate feature—except **Chassis**—under **Monitor** in the control tree. You can separately monitor the chassis only on a PortMaster 4.

To configure settings, click the appropriate setting under **Configure** in the control tree. To configure modems, lines, ports, or Ethernets, go to the section of the control tree starting after **Users** and select the parameter name to be configured.

### Integrated Network Access Module (INA)

The INA module is a product that provides routing functions to the MERLIN MAGIX IS. Access to all PMVision functions is supplied by a separate menu found under **INA** in the control tree. (Figure 2-3). For more information, see the MERLIN MAGIX Integrated Network Access (INA) Module Installation and Configuration guide.

![INA Module Function Menu](image)

### PortMaster 4

The PortMaster 4 is made up of a collection of individual modules and boards that plug into 10 slots in a main chassis. In addition to the system manager module, which contains the Ether0 and Ether1 interfaces, the chassis can include Quad T1 or Tri E1 boards with or without modems, T3 multiplexer boards, standalone Ethernet boards, and other advanced functions.

Because of this structure, settings such as modem numbers, port numbers, and line numbers are associated with a particular board in a PortMaster 4 chassis. When configuring or monitoring such settings, you must also use the board (slot) number.

A special case is the system manager module, which always occupies slot 4. This module contains both an Ether0 interface in slot 4 and a Ether1 interface in a virtual slot 10.

### Monitor Functions on a PortMaster 4

When monitoring a PortMaster 4, you select the desired function from the control tree. When you choose one of the monitoring functions shown in Table 2-1 you must also select a board number from the drop-down list box. PMVision displays information about functions controlled by that board. If only one board handles that function, no special selection is needed. For example, to display all user sessions on a PortMaster 4 that has two Quad T1 boards, you must display the sessions for board 0 and separately display the sessions for board 1.
Table 2-1  Functions Requiring Selection of PortMaster 4 Board Number

<table>
<thead>
<tr>
<th>Monitor Functions</th>
<th>Configuration Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>IMT</td>
</tr>
<tr>
<td>Modem Details</td>
<td>Lines</td>
</tr>
<tr>
<td>Session Details</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Interfaces</td>
<td>Ports</td>
</tr>
<tr>
<td></td>
<td>Modems</td>
</tr>
<tr>
<td></td>
<td>Channels</td>
</tr>
<tr>
<td></td>
<td>L2TP</td>
</tr>
</tbody>
</table>

Configure Functions on a PortMaster 4

Table 2-1 shows the configuration functions for a PortMaster 4 that require you to select the PortMaster 4 board before selecting the item to be configured. To do so, select Configure → Boards. A list of all the boards for the active PortMaster 4’s is displayed. Select the board to be configured and click Edit. You can then select the particular item to be configured.

PMVision Functions

PMVision function categories are Monitor, Graph, Diagnose, Maintain, Command and Configure.

Monitor Functions

Monitor functions allow the user to observe settings or operations for the connected devices. Figure 2-4 shows the available PMVision monitoring functions.
Basic Operation and Display

The Monitor functions display real-time information about the active devices in a table format. Many monitor functions display data for all the active devices in one screen. Scroll bars are provided to navigate the data.

Other monitor functions display the data for one or one particular board on a PortMaster 4. Select the particular PortMaster 4 and board using drop-down lists at the top of the main panel.

Data Display Controls

Each data panel (Figure 2-5) has at least one control button at the bottom of the display—a New Window button. Click this button to “tear off” a window that contains an active copy of the data being displayed. These new windows continue to monitor a particular parameter while allowing PMVision to be used for other functions.

Many data panels contain Reset Counters and Restore Counters buttons. These buttons reset and restore event counters such as bytes in and out and retransmits or calls. Because the counter value is retained with each window, you can maintain separate counts in separate instances of the same data display.

The Reset Counters buttons reset the counters that PMVision maintains internally. Counter values maintained by ComOS are not affected. The Restore Counters buttons return the PMVision counters to the value maintained by the device.
The Monitor → Chassis and Monitor → Users functions contain special control buttons. The Monitor → Chassis panel has On and Off buttons that control the power to the boards in a PortMaster 4 chassis. The Monitor → Users function contains a Reset Port button that resets the port an active user is on and disconnects that user from the device.

**Graph Functions**

Figure 2-6 shows the PMVision graphing functions. The Graph function can display a view of activity for either modems or sessions. Select the activity to monitor from the control tree.

The main panel displays a dialog (Figure 2-7) that allows you to select a particular device to be monitored. The update interval and optional log file can also be selected.

Click Start to begin the graphing process and display the graph. Graph colors can be selected from drop-down menus. Figure 2-8 shows an example of a session usage graph.
Diagnose Functions

The PMVision Diagnose function (Figure 2-9) provides easy setup of various debug scenarios. Click the Debug function to select debug options for all active devices.

Check the Debug box in the panel that appears (Figure 2-10). You can check the Filter box and enter a Perl 5 expression to define a filter for the debug messages. You can check the Echo to File box and specify a file to collect the debug information.

Click the Select button on the debug panel to display a new panel allowing selection of debug options (Figure 2-11). Select the category of debug option in the left window. Select one or more specific options in the right window. Click Set to enable the chosen options. The selected options appear in the enabled debug window at the top of the panel.

For more options, select another category and then choose additional options, clicking Set again to enable them. When all options have been chosen, click Apply to transmit these options to the selected device and redisplay the main debug panel. The debug trace is displayed in a scrollable text box.
The **Clear All** button clears all debug options. **Cancel** closes the debug options panel with no action.

**Figure 2-11  Debug Options Panel**

Maintain Functions

The **Maintain** function provides backup, restore and upgrade operations for the connected device(s). Figure 2-12 shows the PMVision maintain functions.

**Figure 2-12  Maintain Functions**

Back Up

To create a backup file for a particular device or a group of devices, select the **Back Up** function. Select **Entire Configuration** to back up the entire configuration, or check specific items to backup. (Figure 2-13). You can chose between backing up the entire configuration or specify any subset of configuration settings.

After selecting the backup options, enter or browse to the backup filename and click **Back Up** to begin the process.
For ComOS 3.8 and earlier releases, restoring from a PMVision backup produces null passwords in the user table. If a user entry has a null password, the PortMaster does not prompt the user for a password at login. As a result, the user might be unable to log in. In addition, an unauthorized user might gain access to the user account because no password is required. Use PMVision or the command line interface to add the user passwords.

For ComOS 3.8 and earlier releases, the PMVision backup operation fails to save RADIUS and ChoiceNet secrets so that the previous passwords and secrets remain in effect. You must add the administrative password and any secrets to the backup file.

The administrative (\texttt{!root}) password is \textbf{never} saved for any ComOS version. The restore operation will leave the administrative password unchanged.

\textbf{Restore}

The \textbf{Restore} function allows the set of configuration values captured during the Back Up function to be entered into the selected device(s). These values overwrite any values existing in the target device(s). A backup file created with a selective backup overwrites only the selected configuration values.

To restore, enter or browse to the backup filename on the Restore panel (Figure 2-14) and click \textbf{Restore}.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{figure2-13}
\caption{Backup Panel}
\end{figure}

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{figure2-14}
\caption{Restore Panel}
\end{figure}
Upgrade

The **Upgrade** function (Figure 2-15) allows a new version of ComOS to be loaded into the active device(s). The file containing the latest version of ComOS must be available to the computer that is running PMVision. Check **Reboot after Upgrade** to automatically reboot after the upgrade is complete. If the upgrade fails for any reason, PMVision will **not** perform the automatic reboot.

Figure 2-15  Upgrade Panel

Cloning

The **Back Up** and **Restore** functions can be used together to “clone” or copy the configuration of an existing device to another device or group of devices. This feature can be useful for configuring one or more new devices.

To clone, use the **Back Up** function to record a complete or partial configuration of the master device. Use the **Restore Function** to load this configuration into the desired devices. Several devices can be configured simultaneously.

For example, suppose you wanted to configure global settings on several new devices. Back up just the global settings from an existing device by selecting the **Global** checkbox in the backup panel (Figure 2-13). Then activate connections to a number of new devices, and load the global values into all of them using the **Restore** function.

Command Functions

**Command** functions allow you to enter and run ComOS commands for any or all of the active devices. ComOS commands are entered in the command field appearing at the bottom of the Command panel. The command is run on all active devices. The results for each device is displayed in a separate scrollable window.

You can use the **Ignore Commands** checkbox to selectively disable the command feature for some or all active devices.
The following ComOS commands cannot be entered from PMVision:

- attach
- dial
- ping
- pmlogin
- ptrace
- rlogin
- set debug (Use Diagnose → Debug instead.)
- telnet
- tftp
- trace

Configure Functions

Select a Configure function by clicking the desired function name in the control tree (Figure 2-17). When a function is selected, the main panel shows either a configuration panel or a configuration display.
When working with a PortMaster 4 product, you configure functions such as ports and lines by selecting **boards** first. (See “Configuring PortMaster 4 Boards” on page 2-15.)

**Working with Configuration Panels**

Configuration panels (Figure 2-18) have **Save** and **Refresh** control buttons at the bottom. Enter or edit the desired data, and click the **Save** button. A dialog appears to confirm the data to be changed. If you must reboot the device to update the data, a dialog box allows the choice between rebooting now or later.

**Working with Configuration Displays**

Displays (Figure 2-19) have two or more control buttons at the bottom. Click the **Add** button to add a new entry and display a configuration form. Enter the data and click **Save**.
You can edit or delete a setting by first selecting the setting to be changed. Clicking **Edit** displays a configuration panel. Modify the displayed data and click **Save**. Clicking **Delete** erases the selected settings. Use the **Refresh** button to refresh the displayed data and confirm that settings have been updated.

**Figure 2-19  Configuration Display Example**

![Configuration Display Example](image)

**Copying and Pasting Settings into Displays**

Use the copy and paste functions to copy configuration settings from one device to another. Activate the devices to be worked with, and select the configuration function to be used. Select the desired setting to copy.

From the menu bar, select **Edit → Copy**. Make sure that the configuration display(s) for each destination device are visible. Select **Edit → Paste** from the menu bar. Select the device(s) to update using the selection dialog.

**Configuring PortMaster 4 Boards**

To configure the settings shown in Figure 2-20, you must first select the particular board to be configured. Select the **Boards** function in the control tree.

**Figure 2-20  Board Dependant PortMaster 4 Settings**

![Board Dependant PortMaster 4 Settings](image)

From list of boards for the active PortMaster 4 products displayed (Figure 2-21), select the board to be configured. Click the **Edit** button to configure the settings. The slot number of the board selected appears in the control tree under **Boards**.

**Figure 2-21  Board Selection Display**

![Board Selection Display](image)
Use the Configure Boards panel (Figure 2-22) to enter basic settings for the selected board. Select buttons on the panel to access further items to be configured. You can also use the control tree to select configuration items instead of using the buttons.

Figure 2-22 Configure Boards Form

Configure setting for Intermachine Trunks (IMT), lines, ports, modems and L2TP on Quad T1 or Tri E1 boards. Ethernets can be configured for the system manager module on slots 4 and 10 or for a standalone Ethernet board. Channels can be configured for the T3 Mux or STS-1 Mux board.
This chapter defines the system requirements for PMVision, provides instructions for installation and deinstallation, and describes some command line options. Topics are as follows:

- “System Requirements” on page 3-1
- “Installation Instructions” on page 3-1
- “Deinstallation” on page 3-2
- “Command Line Features” on page 3-3

**System Requirements**

PMVision is a Java-based product that runs on any system with Java Development Kit (JDK) or Java Runtime Environment (JRE) version 1.1.6 or later installed. Nondevelopers can use the JRE rather than the JDK. Currently, JDK 1.1 and JRE 1.1 are available for the following platforms:

- Windows NT 4.0
- Windows 95
- Solaris x86 2.5.1
- Solaris 2.5.1
- Linux 2.x
- FreeBSD
- SGI IRIX 6.3
- HP-UX 10.02
- Alpha Digital UNIX 4.0
- IBM AIX 4.1
- Macintosh
- Other platforms: Check the javasoft website

Information and downloads of the latest JRE and JDK can be obtained from [http://www.javasoft.com/products/jdk](http://www.javasoft.com/products/jdk).

**Installation Instructions**

To install PMVision, follow these steps:

1. **Download files from** [http://www.livingston.com/forms/one-click-dnload.cgi](http://www.livingston.com/forms/one-click-dnload.cgi).
2. For non-Solaris UNIX systems only, define the path for jre/bin in your .cshrc file.
   - For example, if you install the JRE in the /usr/local/lib directory, your .cshrc file must have the following entry:
     
     ```
     set path=/usr/local/lib/jre/bin $path
     ```
     
   - If the JDK has been installed, then change the pmvision script to use the java command instead of jre.

3. Run the installation.
   - For Solaris, enter the following commands on the command line:
     
     ```
     tar xvf pmvision1X_solaris.tar
     ./pmvision_install.bin
     ```
     
   - For other UNIX systems, enter the following commands on the command line, replacing /usr/local/lucent with whatever path you prefer:
     
     ```
     mkdir /usr/local/lucent
     mkdir /usr/local/lucent/pmvision
     cp pmvision1X_unix.tar /usr/local/lucent/pmvision
     cd /usr/local/lucent/pmvision
     tar xvf pmvision1X_unix.tar
     rm pmvision1X_unix.tar
     ```
     
   - For Windows, unzip the pmvision1X.zip file, run the pmvision_install.exe program, and follow its instructions.
   
   - For Macintosh, unstuff the pmvision1X.sit file, run the pmvision_install program, and follow its instructions.

4. Set up PMconsole.

   An adequate number of connections through port 1643 must be set up on your device. Each simultaneous PMVision user requires a connection. Each Java based tool or wizard that is used at the same time also requires a connection. If you are using a ChoiceNet server, make sure to increase the maximum number of connections to at least 2 and preferably 10.

   - You can increase the number of connections using PMVision itself. Select Configure → Global. Change the Maximum PMconsole Connections value to 10 and click Save.
   
   - You can also log in to your device through the console or a Telnet session and type the following command:
     
     ```
     set maximum pmconsole 10
     ```

Deinstallation

   - On a Solaris, Windows, or Macintosh system, an application called Uninstall PMVision is placed in the Lucent/PMVision directory. Run this application to remove PMVision from your system.
- On Solaris, if the local jre directory still exists after you run `Uninstall_PMVision`, remove the directory with the command `rm -rf jre`.
- On a UNIX system, remove the shell script and jar files to remove PMVision from your system.

**Command Line Features**

When starting PMVision, you can add the following options to the command line:

- `h` Hostname
- `u` Username
- `p` Password
- `g` Debug level
- `-l` (This option logs debug output to `debuglog.txt`.)

**Login Options**

Use the `-h`, `-u`, and `-p` options together to force PMVision to log in to the specified device at startup. For example:

```
pmvision -h Hostname -u \\
"!root" -p Password
```

If only `-h` is specified, the Connect dialog box is displayed with the hostname filled in.

**Debug Options**

The `-g` Debug level option specifies the debug level. Valid debug level values are the following:

- **0** - (NONE)—No debug output
- **10** - (FATAL_ERRORS)—Debug output for fatal errors only
- **20** - (ALL_ERRORS)—Debug output for all errors (the default)
- **30** - (DEBUG)—Useful debug information
- **40** - (VERBOSE)—More debug output than you can possibly stand

The `-l` option usually sends all debug output to the `debuglog.txt` file the directory PMVision is installed in.

You can also set the debug level by selecting **Help → About** from the menu bar (Figure 3-1). The debug level can be selected from a drop-down selection box. The path to the debug log, platform, and Java Runtime Environment version will also be displayed.
Figure 3-1 Help About Panel
1. Hardware Warranty

A. Lucent Technologies warrants that for twelve (12) months from the shipment date of hardware products (the “Warranty Period”), the products that are manufactured by Lucent Technologies will operate in accordance with Lucent Technologies’ standard specifications or documentation.

B. When Lucent Technologies performs the installation, the warranty period begins on the date of installation. If customer schedules or delays installation by Lucent more than 30 days after delivery, warranty begins on 31st day after delivery.

C. If a product does not operate in accordance with Lucent Technologies’ standard specifications or documentation during the warranty period, Lucent Technologies will have such product either repaired or replaced, at its sole option, without charge for material or labor when it is returned accompanied by a serial number, documentation of the delivery date, or other evidence satisfactory to Lucent Technologies that such product remains entitled to warranty protection.

D. If a product fails in service during the warranty period, the customer is responsible to (remove/de-install) the (product/part) and ship the defective piece back to a Lucent Technologies manufacturing site. Shipping expenses back to factory and installation of the replacement (part/product) is the responsibility of the customer.

E. With respect to hardware products not manufactured by Lucent Technologies, Lucent Technologies, to the extent permitted, assigns you any warranties given by the vendor of such products.

F. Replacement products or product components may, at Lucent Technologies’ option, be new, factory reconditioned, refurbished, remanufactured, or functionally equivalent and will be furnished only on an exchange basis. Any removed products or product components will become the property of Lucent Technologies.
2. Software Warranty

A. Lucent Technologies warrants that for ninety (90) days from the shipment date of the software product(s), the media will be free from defects in material and workmanship.

B. Maintenance releases (fixes) to software products that have remote downloading capabilities will be available from the Warranty WEB Site during the warranty period.

C. When Lucent Technologies installs their software product(s), the warranty period begins on the date of installation. If customer schedules or delays installation by Lucent more than 30 days after delivery, warranty begins on 31st day after delivery.

D. Lucent warrants that software will not fail to execute its programming instructions due to defects in materials and workmanship when properly installed on Lucent Technologies products or products designated by Lucent Technologies.

E. Lucent Technologies does not warrant that the operation will be uninterrupted or error free.

F. With respect to software products not manufactured by Lucent Technologies, Lucent Technologies, to the extent permitted, assigns you any warranties given by the vendor of such products. For purposes of this Agreement, preventive and remedial maintenance does not include the provision or installation of hardware upgrades or reprogramming to add additional capabilities or functionality to the Products maintained under this Agreement, including but not limited to Year 2000 functionality. Although Lucent may provide software upgrades for certain equipment which is the subject of this Agreement for the purpose of achieving Year 2000 compliance in accordance with directions of the original equipment manufacturer, Lucent does not provide any Year 2000 compliance warranty for such equipment or upgrade.

3. Dead On Arrival Policy (DOA)

A. A product is considered (DOA) anytime the product fails to boot up when removed from the shipping container.

B. When a product is (DOA), a new, whole unit replacement will be provided to the customer by Lucent Technologies.

C. Lucent will be responsible for de-installation and shipping costs for DOA products installed by Lucent.
D. When the customer has self-installed a product and it has been determined and confirmed by Lucent as a DOA, de-installation will be the customer’s responsibility; shipping charges will be Lucent’s responsibility.

4. Warranty Policy for Re-Sellers and Distributors

A. When a product is sold through a Re-Seller or a Distributor an additional 90 days of shelf time will be added to the 12-month warranty period.

B. The additional 90 day warranty period will start on the shipment date to the Re-Seller or Distributor.

5. Warranty Exclusions

A. Except as stated in the above warranty, Lucent Technologies and its affiliates make no warranties, express or implied, and specifically disclaim any warranty of merchantability or fitness for a particular purpose. Your sole and exclusive remedy shall be Lucent Technologies obligation, if any, to repair, replace or refund as set forth in the warranty above.

B. The warranty provided above does not cover repair for damages or malfunctions caused by (i) actions of personnel other than Lucent Technologies personnel or personnel of the third party to which Lucent Technologies assigned or subcontracted its warranty obligations; (ii) the attachment to the Product(s) of non-Lucent Technologies furnished equipment or software; (iii) your failure to follow Lucent Technologies’ installation, operation or maintenance instructions, including but not limited to, air conditioning, humidity control or other similar environmental situations; (iv) failure of products not sold by Lucent Technologies; (v) abuse, misuse or negligent acts of non-Lucent Technologies personnel; (vi) power failures or surges, lightning, fire, flood, pest damage or accident; or (vii) force majeure conditions. In addition, Lucent Technologies is not obligated to provide warranty service if you modify the product or software.

C. Lucent Technologies does not warrant uninterrupted or error-free operation of the product(s). Lucent Technologies does not warrant that the product(s) will prevent, and Lucent Technologies will not be responsible for, unauthorized use (or charges for such use) of common carrier telecommunication services or facilities accessed through or connected to the product(s) (“Toll Fraud”).

D. Lucent Technologies will not be liable for any lost profits or revenue of any kind or lost savings, or any incidental, special, exemplary damages or other consequential damages, even if Lucent Technologies or its authorized supplier has been advised of
the possibility of such damages. Lucent Technologies will not be responsible for any
tele-communications charges resulting from incorrect programming, configuration
or misuse of the product. Lucent Technologies will not be liable for any damages
claimed by you based on any third-party claim.

6. Limitation of Remedies

A. Lucent Technologies will replace defective media with a functionally equivalent
CD-ROM or you may terminate your license and destroy all copies of the CD-ROM.
Lucent Technologies will not be liable for any lost profits or revenue of any kind or
lost savings, or any incidental, special, exemplary damages or other consequential
damages, even if Lucent Technologies or its authorized supplier has been advised of
the possibility of such damages. Lucent Technologies will not be liable for any
damages claimed by you based on any third-party claim.

B. The limitation of remedies also applies to any developer of software supplied to
Lucent Technologies and the developer’s limitations of remedies are not cumulative.
Such developer is an intended beneficiary of this section.

7. Warranty Support Services

A. 90-day advance replacement of field replaceable units, remaining 9 months of
service will be field replaceable unit return to factory process.

B. 90 day 7 X 24 access to On Line Support Services, providing diagnostic support via
private chat with Lucent engineer.

C. 12 month 7 X 24 access to enabling self-help.

D. 12 month 7 X 24 access to extensive technical database providing product
information, frequently asked questions and technical advice through the WEB page
providing self help information.

E. 12 month 7 X 24 access to International Return Materials Authorization Policy
(RMA), including forms & RMA number issuance.

F. 90 day 7 X 24 access to Software maintenance releases will be available for products
that have remote download capabilities.
8. Not Covered Under Warranty Support Services

A. Installation or configuration support which are available as billable services.
B. On site diagnosis or problem resolution.
C. De-installation or re-installation of HW/SW.
D. On site repair.
E. Trial/Demo support.
F. Beta support.
G. New Software features and functionality are not included in the warranty maintenance releases.
Index

A
about this guide v
additional references vi
audience v

B
Backup function 2-10

C
capabilities, PMVision 1-1
cautions ix
chassis, monitor 2-8
classes, PortMaster x
cloning 2-12
Command function 1-3, 2-12
customization options 3-3
configuration displays 2-14
configuration panels 2-14
Configure functions 1-3, 2-13
configuring
boards 2-15
PortMaster 2-6
connecting to a PortMaster
basic connection 2-3
multiple devices 2-4
connection panel 2-2
contact information
CALA x
Europe, Middle East, and Africa ix
mailing lists x
North America, Latin America, and Asia
Pacific x
technical support ix
control tree panel 2-1
conventions in this guide viii
copying settings 2-15

D
data display controls 2-7
dead-on-arrival policy A-2
debug options
PMVision 3-3
PortMaster 2-9
deinstallation 3-2
Diagnose function 1-3, 2-9
display, PMVision 1-1
displays, configuration 2-14
distributors, warranty for A-3
DOA policy A-2
document
advisories ix
copyright viii
documentation, related

E
exclusions from warranty A-3

F
functions
Backup 2-10
Command 2-12
Configure 2-13
Diagnose 2-9
Graph 2-8
Restore 2-11
Upgrade 2-12

G
Graph function 1-2, 2-8

H
hardware warranty A-1
help bar 2-3

I
INA module 2-5
installation instructions 3-1
IRX 2-4

L
limitations of remedies, warranty A-4
login options  3-3
Lucent Technologies InterNetworking Systems
Global Warranty  A-1

M
mailing lists, subscribing to  x
main panel  2-3
maintain function  1-3
menu bar  2-3
monitor
  chassis  2-8
  PortMaster 4  2-5
  users  2-8
Monitor functions  1-2,  2-6

N
NetCare
  training  x
New Window button  2-7
not covered under warranty  A-4
note icon  ix

O
Office Router  2-4
options, command line
  debug  3-3
  login  3-3

P
panels, configuration  2-14
pasting settings  2-15
PM console setting  3-2
PM Vision
  capabilities  1-1
  deinstallation  3-2
  display  1-1
  installation  3-1
  interface  2-1
  Monitor functions  2-6
  starting  2-1
PM Vision functions  2-8
  Command  1-3,  2-12
  Configure  1-3,  2-13
details  2-6
  Diagnose  1-3,  2-9
  Graph  1-2,  2-8
  Maintain  1-3
  Monitor  1-2,  2-6
PM Vision panels
  connection  2-2
  control tree  2-1
  help bar  2-3
  main  2-3
  menu bar  2-3
  status bar  2-3
PortMaster
  basic connection  2-3
  multiple connections  2-4
  new software releases  ix
  software upgrades  ix
  training  x
PortMaster 2  2-4
PortMaster 3  2-4
PortMaster 4
  configuring boards  2-15
description  2-5
portmaster-announce mailing list  x
PortMaster documentation  v
portmaster-radius mailing list  x
portmaster-users mailing list  x

R
references
  books  viii
  RFCs  vi
related documentation  v
releases, new software  ix
requirements, system  3-1
resellers, warranty for  A-3
reset counters  2-7
restore counters  2-7
restore function  2-11

S
set maximum pmconsole  3-2
settings, copy and paste  2-15
software, new releases and upgrades  ix
software warranty  A-2
starting PMVision  2-1
status bar  2-3
support, technical  ix
support services, warranty
  covered  A-4
  not covered  A-4
system requirements  3-1
T
  tech-bulletin@livingston.com mailing list  xi
  technical support  ix
  training, PortMaster  x

U
  Upgrade function  2-12
  upgrades, software  ix
  users, monitor  2-8
  using PMVision  2-1

W
  warning icon  ix
  warranty  A-1
    exclusions  A-3